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Matricule 
1. roll, register.   
2. (Mil) regimental number; (Admin) administrative, official or reference number.  
Source : Collins & Robert French-English English-French Dictionary 
 
Matricules  
Visual documentary register of the history of Studio X X,   
Matricules offers the Canadian public and community at large, an artistic glimpse into our trajectory,   
as well as an overv iew of our critical reflection and history regarding issues of creation,   
feminism and engagement with technologies of tomorrow's digital society. 

 
 
 
 

Matricules was made possible through Canadian Heritage's Canadian Culture Online initiative. 
 

 



 
 

 

   

 
 
 
 
 
 
 

Summary 
 
 
 
 
1. Matricules Archiving Guide 
 

How to Archive a document 
 
 
 
2. Matricules Digitilization Guide 
 

How to Digitize and Prepare a Document for Archiving 
 
 
 
3. Politique d’archivage Matricules 
 

Understanding the Matricules Archiving System 
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THE MATRICULES ARCHIVING METHOD 

 
User’s guide V.2010 

 
Drafted for Studio XX by Annie Bonsaint, April 2008 

Revision by Stéphanie Lagueux, June 2010 
Translation by Anne Kmetyko, May 2008, Éric Bréchard, 2010 



 2 

SUMMARY OF CONTENTS 

 
DOCUMENTS “TO BE PROCESSED”................................................................ 3 
 
ASSIGNING AN ACCESSION NUMBER TO A DOCUMENT  ........................... 4 
 
IDENTIFICATION/LABELLING OF MATERIAL .................................................. 5 
 
ON LINE SERVER / DOCUMENT FILING SYSTEM  ......................................... 6 
 
ADDING A MATRICULES DOCUMENT IN DRUPAL .......................................... 7 
 
ADDING A MATRICULES EVENT IN DRUPAL................................................. 10 
 
ADDING A MATRICULES ENTITY IN DRUPAL ................................................ 14 
 
MODIFYING A MATRICULES ITEM IN DRUPAL .............................................. 15 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



 3 

1. DOCUMENTS «TO BE PROCESSED» 

New documents that are in the process of being added to the Matricules archive can be placed 
in the «to be processed» file when these new documents cannot be registered or numbered 
immediately. 

Material (Physical) and Digital documents will be processed differently according to their type.  

 

 Material:  
- Place the item in the red box identified by 
« To be identified, to be processed» 

 
 
The material will be stored in this box until 
we are ready to proceed to the next step. 
 

 

 Digital: 
- Identify the file with an appropriate name 
to help locate it in the future. 

- Place the file on the Studio’s local server in 
the Matricule section (not to be confused 
with the UQAM web server). A password is 
required to log on. 

________________________________ 
 
- Proceed to the TO BE PROCESSED file 
(in red). 
 
- Place it in the TO BE IDENTIFIED file (also 
in red).  
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2. ASSIGNING AN ACCESSION NUMBER TO A DOCUMENT 

• Refer to the document Matricules Archiving Policy to understand how an accession 
number is created. 

• Understand the configuration of an accession number. 

• Open the Excel document MatriculesDocumentCatalog.xls  
The file is located in the Matricules section of Studio XX’s server. 

• Enter the required data in the fields/columns according to the established procedures. 

 

• For MATERIAL documents; continue to the next step Identifying material with the P-
Touch labeller. 

• For DIGITAL documents:  
- Rename the file with its new accession number. 
- Place the file onto the server – see the section Filling system for documents on the 
Studio’s local server. 

• For a photo gallery, which is a Matricules document, and has its accession number, 
each photograph that is part of a gallery must be renamed with an accession number 
followed by a distinct ID number: (Ex. 2007FOR30406O_201.JPG). An application like 
Renamer (MAC) can be used for batch renaming of files. Leave all the photographs on 
the local server. However 10-15 photographs should be selected and optimised for the 
web (reduced in size and colour corrected) before importing them into Drupal. 
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3. IDENTYING MATERIAL WITH THE HELP OF THE P-TOUCH LABELLER 

Be sure to have obtained the accession number 
previously created in Excel. 

Studio XX is equipped with the portable « P-Touch » 
labelling system. This little machine prints self-adhesive 
labels on a laminated tape. 

The P-Touch labeller is kept in a red box with the stored 
material. The box is labelled: 
« TO BE IDENTIFIED, and TO BE PROCESSED»  
 
Before printing: Make sure that the type settings (height 
and spacing) are configured as described in the printed 
user’s guide. The instructions are explained in detail. 

Once this step is completed: 

- Print the accession number 
- Apply the label on the material, ideally on the support 
envelope. 

 

 

- Store the document in it’s corresponding archive box (by year). 

 If this material document is to be digitally captured, proceed to The Digitalization Guide for 
Matricules Material. 

Once this step is completed go to the section Classification System for Documents on the 
Studio’s local server in order to learn how to archive the digitalized document. 
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4. MATRICULES DOCUMENT FILING SYSTEM ON THE STUDIO SERVER 

The system for archiving digital files is explained in the document Matricules Archiving Policy. 

To upload a file on the server: 
 
- Connect onto the Studio’s local server by choosing the MATRICULE section (requires a 
password: _______________________). 
 
- The tree structure is as follows: YEAR / CATEGORY CLASSIFICATION (FBR, FES, PUB…) 
 
Here is an example: 

 

- Place the document in the appropriate file. The file name (which is the accession number) 
always starts with the year followed by the category classification (FBR, FES, PUB…) 

In the following example: 2005PRM30325O.mp3  
 - Find the file named 2005, then  
 - Choose PRM 
 - Place the file in that location. 
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5. ADDING A MATRICULES DOCUMENT INTO DRUPAL 

On the Studio XX web site: 
http://www.studioxx.org/en/user 

- Open a session in Drupal* 
*First you must have some basic notions of 
how Drupal works. A user name and password 
are required to add or modify the content. 

In the left menu select Create content 
then choose Document Matricules . 
http://www.studioxx.org/en/node/add 

Complete the fields with the same 
information previously entered in the Excel 
document. (documentspreadsheet.xls). 
 

ATTENTION: The LANGUAGE field must 
be set to “Language neutral”, unless there 
are a translated version of the same 
document (ex: a Press release on PDF). In 
the field Description of Content you can 
specify if the event is in English or in 
French (in the case of a press conference 
or an interview etc…). 

Only when this new document will have 
been linked to it’s corresponding 
Matricules Event will a language be 
chosen. 
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• Determine what type of document it is: Audio, Video, Text or Image. Choose the appropriate 
field (the permitted type and extension are indicated just above the field).  
Note: Enter only ONE TYPE of content even if all the fields are available. 
 

 

• Make sure you are connected to the Studio’s local server on the MATRICULES Section. 

• Click on the BROWSE tab to choose the document (file) to import. Retrieve the file (already 
positioned in right place) on the local server in the MATRICULES section. 

• Click the UPLOAD tab to upload the document into Drupal. 
 
Please Note: Importing a QuickTime file (.mov) takes a while. 
Allow approximately 30 minutes for a document of about 150-200MB 
Wait for the upload process to be complete to avoid any loss of media to the document. 
For smaller files (< 20 MB), normally the length of time is not more than 5 minutes. 
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• Source documents (« afférents » documents) : 
A distinction must be made between a Source Document (afférents documents) for a 
Matricules Document and a Source Document (afférents documents)  for a Matricules 
Event. In this case (for a Matricules Document) a source document is the second part of a 
video file. The source document must already be imported into Drupal so that you may 
select it at this point. At the start of the capture process, a small circle located to the right will 
begin to spin; this indicates that Drupal is searching in the database. Choose your Source 
Document (afférent document). 

 

• Click on the Save tab to confirm, and add the new Matricules Document into the archive. 

 

• Presto! It is added! Now you can link this Matricules Document to its Corresponding Event 
if such is the case. 

Note: This addition is made in the database. However if you perform a search immediately 
after for that Document it might not be located right away. Drupal updates (refreshes) its 
database every 60 minutes +/-. That means that the Document is in effect in the database, 
but the user does not yet have access to the updated data. 
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6. ADDING A MATRICULES EVENT IN DRUPAL 

• In the left menu, go to Create content 

• Choose Event Matricules 

 

• In the Title field, enter the exact official title of the Event to be added. 

• Choose the language in which you wish to import this new Event. 
In general, Studio XX’s productions and activities are bilingual. You will have to enter the 
Event twice, once in English and once in French. 

• Photo Galleries: If a photo gallery exists that corresponds to this Event, enter its accession 
number here. Note: You must first add this gallery as a Matricules Document in Drupal.  
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• Add a thumbnail of the Event. The image that represents the Event will appear on the site as 
such:  

 

• The dimensions of this image are 150 x 150 pixels. 
2 options are now possible to post this image:  
 

Create the thumbnail in any 
photo software application in 
the right format of (150 x 150). 
Optimise it for the web. 

The image is then ready to be 
imported into the following field: 

Let Drupal create the thumbnail. In 
this case it is not necessary to use a 
photo software application. All you 
need is to choose an image (of any 
dimension) from the following field: 

 

 

• Click on BROWSE to retrieve the image to be imported. This can be placed on the desktop 
of your computer, but must also appear in the photo gallery of the Event (as an archive). 

• Click on UPLOAD to upload the image into Drupal 

• New fields to complete will appear: 

 

Alternative Text: Text that 
replaces the image if image does 
not appear. 

Title: Textual description of the 
image when you mouse over it. 
 
«Delete» box to check to remove 
image. 
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• Adding a description of the Event in the field provided for that purpose: 

 

 
 

• Four options are given for the data input format. 
The choice of data input format is up to the user. 
Some notions of HTML mark-up are essential in order to integrate text according to the 
required formats (bold, italics, hyperlinks etc.). “” 

• There are two methods for translating a document matricules : 
  
When there are two versions of a document (ex. PDF communication) 
 - we create 2 separate documents and therefore 2 document numbers in the catalogue
 - in the site we create de the document in French (language field)  
 - we create the other document in English  
 - we link the 2 documents with the “translate” tab by inputing the document number 
 ** Both documents need to be created first sot hey could be linked. 
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When there is only one document and we only want to translate the subject and description 
fields: 
 - we create a document and set the language field to “neutral”  
 - we deactivate the rich text in the description field 
 - we select “HTML complet avec multilingue” as the input format 
 - we add the texts like this: 

== fr ==  
text in French 
== en == 
text in English 
 

• Link the Source Documents to the Event by entering the accession numbers in the field 
designated for that purpose. Every type of content (audio, video, participants, PDF Press 
releases and PDF Programs) has a required field to fill in. This content information must 
already be entered as a Matricules Document in Drupal. 

 

• Once these steps have been completed, you are ready to confirm the add of this new Event. 

• Verify if the selected publication options correspond to what you want. « Placed on the 
homepage» will show an excerpt of the event on the home page. This is ideal for upcoming 
or recent events. 

 

• Click on the Save tab to confirm and add this new Matricules Event in the archive. 
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7. ADDING A MATRICULES ENTITY IN DRUPAL 

An Entity refers to a person, often an artist or an organisation. 
The biography of the artist or the mandate of an organisation is entered here. 

Enter here miscellaneous information requested on Entity: 

To access this view: 

• In the menu select Create Content, 
located on the left side of the page. 

• Choose Entity.  
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8. MODIFYING A MATRICULES ITEM IN DRUPAL 

To modify an existing item (Document, Event or Entity) in Matricules, follow these steps:  

Open a Drupal* session 
http://www.studioxx.org/ 

Choose from the Administer 
menu Manage Content. You can 
also go through search. 

Choose the Event to be modified 
by clicking on its title. 

You will be in “View” mode by 
default. 
 
Choose the “Edit” tab to make 
changes.  

The fields will now be unlocked and can be modified. 

Click on the “Save” tab to confirm the modifications. 

 



!

!

MATRICULES – STUDIO XX 
GUIDE DE NUMERISATION

SETTINGS DE NUMÉRISATION (pour MiniDV/SD) :

1. Lancez le logiciel. Connectez la caméra au port
Firewire de l’ordinateur. Allez ensuite dans
Audio/Video Settings de l’onglet Final Cut Pro :

2. Dans Sequence Presets, sélectionnez le
preset DV NTSC 48 khz (copy) pour nu-	

	 mériser d’une source DV, puis cliquez		
deux fois pour ouvrir la boîte de dialogue 
du tableau 3.

par S.T, juin 2010



!

!

!

3. 	 Choisissez les options suivantes :

     	 Frame Rate : 720x480 (3:2)     
     	 P.A.R : NTSC - CCIR 601 (+ Anarmophic 16:9 	
	 s’il s’agit d’une source Widescreen)
     	 Field Dominance : None     
	 Timebase : 29.97

   	 Ne cliquez pas sur Ok tout de suite.

4. 	 Dans Quicktime Video Settings du tableau 		
	 3, cliquez sur Advanced pour ouvrir la boîte 		
	 de dialogue suivante. 
	 Assurez-vous que la qualité est à 100%     		
	 (Best) et que le Scan Mode est Progressive.                                                  
    
    	 (Changez l’Aspect Ratio à 16:9 s’il s’agit d’une 	
	 source Widescreen)

   	 Cliquez sur Ok.

5. 	 De retour au menu principal de Audio/Video 		
	 Settings, sélectionnez l’onglet Capture Presets. 
	 Choisissez le preset DV NTSC 48 khz (copy) 		
	 en cliquant deux fois dessus.



!

!

!

* Si vous lisez [Missing] DV Video 
au lieu, redémarrez la caméra et 
ensuite le logiciel pour régler ce 
problème.

7. 	 Dans Device Control Presets, laissez
	 le setting par défaut à FireWire NTSC.

6. 	 Assurez-vous que sous Quicktime
	 Video Settings, l’option Digitizer lit bien :
	 DV Video + Canon DV (ou bien le modèle
	 de la caméra que vous utilisez).
	
	 Cliquez sur Ok.

* Par contre, si vous numérisez d’une 
source analogue comme la Hi8, sélec-
tionnez l’option Non-Controllable Device 
pour pouvoir numériser. 
Ainsi, connectez la caméra Hi8 avec le 
convertisseur AVC.



!

8. 	 Une fois terminé, allez dans File -> Log & Capture.

9. 	 Assurez-vous que les presets que vous venez de choisir sont sélectionnés dans Capture Settings.

Pour entendre l’audio durant la numérisation, sélection-
nez l’option Audio sous l’onglet Clip Settings, et ensuite 
sélectionnez Preview.

Assurez-vous  que le mode stéréo est également sélec-
tionné (icône des 2 cercles entrelacés ci-bas).

 



10. 	 Appuyez sur le Capture Now de la fenêtre principale et ensuite appuyez sur le Play de la caméra pour
	 commencer à numériser.

11. 	 Une fois la numérisation terminée, appuyez sur Escape (bouton dans le coin supérieur gauche du clavier).
	 Le clip apparaîtra dans la fenêtre de projet sous le nom Untitled1. Sauvegardez le projet et renommez la
	 séquence avec le même nom du projet pour pouvoir l’exporter plus tard.

SETTINGS D’IMPORTATION DE CLIPS (pour HD) :

1. 	 Pour importer des clips HD pré-numérisés venant d’un disque dur externe, créez un nouveau projet et allez dans 	
	 File -> Import -> Files... et sélectionnez les sources .mov à importer.

2. 	 Une fois les clips importés, naviguez dans la fenêtre de votre projet en tirant le “scroll bar” vers la droite. Vous 
	 verrez toutes les informations et spécifications de votre séquence et des clips que vous venez d’importer.
	 Pour vous assurer que vous avez les bons settings choisis pour votre séquence et vos clips HD, regardez la case 	
	 Frame Size, qui devrait indiqué les mêmes dimensions pour tous. Dans le cas ci-bas, vous voyez que votre 		
	 séquence est en format SD (720 x 480) et que vos clips sont en HD (1440 x 1080).

3. 	 Si vous devez changer le Frame Size de votre séquence pour matcher vos clips, sélectionnez la séquence en 		
	 faisant un right-click et allez dans Settings.



5. 	 Une fois bien sélectionnés, les settings se devraient lire comme tel :
	
	 Frame Rate : 1440 x 1080    
     	 P.A.R : HD (1440 x 1080)      	
	 Field Dominance : Upper (Odd)     
	 Timebase : 29.97
	
	 Quicktime Video Settings

	 Compressor : HDV 1080i60

4. 	 Choisissez le setting correspondant à l’information du clip que vous avez lu dans la fenêtre de votre projet, 	
	 comme montré dans le tableau 2 (dans ce cas-ci, 1440 x 1080). Votre séquence devrait être de la même taille 	
	 que vos clips.

6. 	 Sélectionnez vos clips et en faisant un “drag-and-drop”, et placez-les sur votre timeline.



13. 	 Tout en sélectionnant l’image de la 	
	 fenêtre	Preview, tirez-la en dessous 	
	 sur la timeline. 
	 Elle devrait faire 4 secondes.

SETTINGS POUR L’INTRO:

12. 	 Importez le fichier JPEG studioxx_logo_2008 et celui dont vous venez de modifier pour l’intro à partir du
	 template PSD 3lines. Double-cliquez sur le fichier studioxx_logo_2008 pour l’ouvrir dans le Viewer.
	 Une fois dans le Viewer, cliquez sur l’image et appuyez sur la lettre « i ». Ensuite, entrez la donnée
	 suivante: + 400 (+ enter), suivi par la lettre « o ».

8. 	 Si vous voyez la boîte de dialogue suivante, cliquez sur Yes.



14. 	 Dans la fenêtre principale des projets, sélectionnez l’onglet Effects.
	 Sous Video Transitions -> Dissolve, choisissez l’effet Fade In 	
	 Fade Out Dissolve et tirez-le jusqu’à la timeline en-bas, à la fin 	
	 du clip du logo.

15. 	 Sélectionnez ensuite le fichier JPEG que vous avez modifié pour l’intro (titre de l’événement, date, etc..), et 	
	 double-cliquez sur le fichier pour l’ouvrir dans le Viewer.
	 Une fois dans le Viewer, cliquez sur l’image et appuyez sur la lettre « i ». Ensuite entrez la donnée suivante: 	
	 + 400 (+ enter), suivi de la lettre « o ».
	 Ensuite re-suivez les étapes #13-14, en l’ajoutant directement collé derrière le clip du logo.

	 (Vous pouvez également ajuster le type de fondu que vous voulez en sélectionnant un des 3 icônes dans le 	
	 Viewer (au centre en-haut), soit Beginning, Center ou End.)



PROCÉDURE DE MONTAGE :

16.	 Une fois les 2 clips collés ensemble avec les Fade In + Out, ajoutez le clip Untitled1 que vous avez
	 numérisé directement après. Rajoutez un Fade In du menu Effects au tout début de la séquence et encore un
	 autre à la toute fin (qui dure environ 3 secondes au moins), sur la piste vidéo ainsi que sur les pistes audio
	 (Effects-> Audio Transitions -> Cross Fade - 0db).

17. 	 Tout au long de la séquence, assurez-vous que les niveaux sonores sont corrects. En moyenne, ils devraient lire 	
	 entre  -18 et -6, mais -9 serait idéal.
	 Par contre les bruits de fond ou les ambiances sonores ne devraient pas être aussi 
	 élevées.

En double-cliquant sur la piste audio de la timeline, la fenêtre du Viewer  va 
faire apparaître l’image ci-dessous.
Inscrivez le chiffre 0 (+ enter) pour le Pan, pour vous assurer que les pistes audio 
soient bien égales.



18. 	 Tout en écoutant la séquence vidéo, si vous remarquez des grosses différences dans les niveaux de l’audio, sélec-	
	 tionnez la lettre P (pour Pen Tool), et insérez des keyframes pour ajuster les niveaux d’audio, en augmentant ou 	
	 en diminuant les niveaux.

(Vous pouvez également augmenter la taille de l’aperçu des pistes pour plus de précision en cliquant sur le bouton 
que la flèche indique en-bas).

Insérez des keyframes pour corriger les niveaux s’ils augmentent trop à un moment donné, en posant un premier keyframe, 
suivi d’un deuxième qui descend une ou deux secondes plus tard (donc baissez les niveaux), et puis placez un troisième 
keyframe là où les niveaux devraient redevenir corrects, suivi d’un dernier keyframe qui revient au même niveau que le reste 
de la séquence :

19. 	 Une fois le montage terminé et l’audio réglé, allez au tout début de la séquence et appuyez sur la lettre « i », en-	
	 suite allez à la toute fin et appuyez sur la lettre « o ».



20. 	 Sélectionnez la fenêtre de la timeline et allez ensuite 	
	 dans File -> Export -> Using Quicktime Conversion :

21. 	 La boîte de dialogue suivante s’ouvre. 		
	 Nommez le document et choisissez 		
	 l’endroit où le sauvegarder.
	 Cliquez ensuite sur Options.

Quand la boîte de dialogue suivante apparaîtra, cliquez sur 
le bouton Settings de la section Vidéo :

SETTINGS D’EXPORTATION ET DE COMPRESSION :



22.	 Choisissez les options suivantes :

	 Pour une source SD :

	 Compression Type : H.264
	 Frame Rate : 24 fps
	 Key Frames : Automatic
	 Data Rate : Restrict to 465 kbits/sec
	 Optimized for: Streaming

	 (Par défaut si on sélectionne ces settings, la qualité devrait rester à High, et Encoding à Best Quality - Multi-Pass).

	 Cliquez sur Ok.

23. 	 Dans la boîte de dialogue principale, cliquez sur le bouton Size de la section Vidéo pour ouvrir la fenêtre
	 suivante. Dans Dimensions, choisissez Custom et ensuite inscrivez la valeur 500 x 281 s’il s’agit d’une source HD 	
	 (donc 16:9) et 422 x 281 s’il s’agit d’une source DV 4:3, et selectionnez Deinterlace Source Video. 		
	 Cliquez sur Ok.

	 Pour une source HD :

	 Compression Type : H.264
	 Frame Rate : Current
	 Key Frames : Every 300
	 Data Rate : Restrict to 450 kbits/sec
	 Optimized for: Streaming



24.	 De retour dans la boîte de dialogue principale, allez maintenant choisir les Settings de Sound.
	
	 Choisissez les options suivantes :
	
	 Format : IMA 4:1
	 Channels : Mono
	 Rate : 32.000 kHz
	
	 Cliquez sur Ok.

25. 	 Une fois terminé, le tout devrait ressembler à ceci :

	 Assurez-vous que l’option Prepare for Internet
	 Streaming est sélectionnée.

	 Cliquez sur Ok, ce qui vous ramène à la boîte
	 de dialogue initiale de Quicktime Conversion.
	 Cliquez sur Save.



PROCÉDURE POUR MODIFICATION D’INTRO :

1. 	 Si jamais vous devez changer ou rajouter 	
	 une nouvelle intro dans un clip déjà com-	
	 pressé, modifiez le document PSD dans 	
	 Photoshop puis sauvegardez-le comme 	
	 JPEG.

2.	 Importez le nouveau document dans Final Cut avec le fichier studioxx_logo_2008 et suivez la démarche 	
	 des paragraphes #12 à 15 à nouveau.

3. 	 Une fois terminé, faites-un « i » au début de la séquence et un 
	 « o » à la fin des deux clips que vous venez tout juste de 		
	 rajouter. Avec la timeline sélectionnée, allez dans File -> 
	 Export -> Using Quicktime Conversion pour exporter
	 l ’intro. 
	 Choisissez les même options d’encodage que ceux des 		
	 paragraphes #21 à 25, avec l’exception du #24 – laissez la 	
	 boîte de Sound décochée. Cliquez sur Ok et sauvegardez la 	
	 nouvelle intro.



4. 	 Ouvrez le clip auquel vous voulez rajouter la nouvelle intro. Au tout début de ce clip, faites un « i » 	
	 et « o » où se trouve l’ancien intro, suivi d’un CMD-X (Control-Delete) pour l’enlever. Repérez main-	
	 tenant le nouveau clip que vous venez d’exporter et ouvrez-le dans Quicktime. Faites un CMD-A  	
	 (Control-All), suivi de CMD-C (Control-Copy). Allez au tout début du l’autre clip et faites un CMD-V 	
	 (Control-Paste) pour insérer la nouvelle intro.

5. 	 Vérifiez que l’insert est bien et sauvegardez le clip.

NUMÉRISATION D’AUDIO (de source analogue) POUR XX FILES :
1. 	 Ouvrez WireTap Pro. Connectez le lecteur mini-disque avec un câble jack 1/8 de la sortie des écouteurs 	
	 du lecteur à l’entrée du micro de l’ordinateur. Pour un lecteur cassette audio, connectez avec un câble 		
	 RCA les 2 sorties audio du lecteur à l’entrée du micro jack 1/8 de l’ordinateur. 
	 Dans WireTap Pro, sélectionnez la source audio “Line In”  dans la boîte de dialogue principale. Vous 	          
                pouvez aussi régler les settings en allant dans Preferences -> Source One -> Configure,  si jamais 		
	 vous avez des problèmes.



2. 	 Appuyez sur le Play du lecteur et allez ensuite dans les System Preferences de l’ordinateur (situé 		
	 dans le Dock) dans la section Sound. Dans Input, assurez-vous que Line In lit bien Audio line-in port. 	
	 Vous devriez entendre ce qui joue sur le lecteur en même temps.
	 Si le volume est trop fort ou trop faible, vous devez ajuster les niveaux à partir du Input Volume, pour
	 qu’en moyenne les niveaux lisent entre le centre de la barre des niveaux (l’échelle) et le haut. S’il est trop 	
	 proche du haut, le son sera distorsionné. Vous pouvez aussi ajuster les niveaux de lecture directe-		
	 ment sur le lecteur de mini-disque.

4. 	 Une fois réglé, revenez dans le logiciel et appuyez sur le bouton noir (Record) dans la boîte de dialogue 	
	 principale pour commencer la numérisation.

5. 	 Dès que la numérisation est terminée, appuyez sur le bouton carré (Stop) pour sauvegarder.
	 Choisissez un titre pour le fichier et cliquez sur Ok. Le fichier va par défaut se sauvegarder dans la biblio-	
	 thèque de WireTap Pro. Il ne suffira que d’aller le chercher et de faire un “drag-and-drop” sur le bureau.

3.	 Choisissez les settings suivants pour l’encodage des mp3, dans Preferences -> Format :
	
	 Presets : AIFF - CD Quality
	 File Format : AIFF
	 Audio Type : Linear PCM
	 Encoding Type : Integer Big Endian
	 Sample Size : 16-bit
	 Sample Rate : 44.100 kHz
	 Channels : Stereo



1. 	 Une fois le fichier audio sur le bureau, ou bien si vous utilisez un fichier provenant des archives de CKUT en 	
	 format .MOV, faites un right-click pour sélectionner Open With -> Soundtrack Pro.

2. 	 Une fois dans Soundtrack Pro, écoutez l’émission pour déterminer s’il y a une artiste sonore invitée et s’il y a 	
	 une de ses oeuvres jouées. Si oui, laissez le morceau tel quel et notez le dans le fichier Excel. 
	 Si vous entendez de la musique commerciale ou autre, laissez qu’un extrait de 20 à 30 secondes au total. 
	 Pour faire une sélection et supprimer un bout d’audio, traînez le curseur sur la section que vous voulez 	
	 supprimer et faites CMD-X (Control-X).

	 Ensuite, sélectionnez un petit bout d’audio - au début ou bien à la fin du morceau que vous venez 		
	 tout juste de couper - pour faire un Fade In ou Fade Out. Sélectionnez la partie voulue tout en traînant 	
	 le curseur sur la section, et puis choisissez Process -> Fade In (ou Fade Out) de la barre de menu prin-	
	 cipal. Assurez-vous que le fondu est bien réussi, et que l’on n’entend pas une coupe brusque, mais 		
	 plutôt une “transition”.

MONTAGE AUDIO POUR XX FILES :



4. 	 Une fois le montage terminé, sauvegardez le document en allant à File -> Save As. Nommez le fichier et 	
	 choisissez l’emplacement du document, ainsi que le format File Type de AIFF File :

	 Si vous voyez la boîte de dialogue suivante, cliquez sur OK.

File Type : AIFF File
Bit Depth : 16-bit integer
Sample Rate : 44.100 kHz

3.	 S’il y a un bout de l’émission précédente dans l’enregistrement au tout début ou bien à la fin - 			 
	 n’oubliez pas de l’enlever pour que l’émission des XX Files soit la première chose qu’on entend dans le 		
	 mp3.  Faites un Fade In ou bien Fade Out pour que la coupe soit le plus transparent possible.	



5. 	 Lancez iTunes. Allez dans Edit -> Preferences -> Advanced. Assurez-vous que dans l’onglet Import-		
	 ing, Import Using est MP3 Encoder et le Setting est à Good Quality (128 kbps).
	 Importez maintenant vos clips.

6. 	 Sélectionnez-les et allez dans Advanced (dans la barre du menu) et choisissez Convert Selec-		
	 tion to MP3.
	 Une fois terminé, les nouveaux clips apparaîtront en-dessous des clips à 44.100kHz avec le nou-		
	 veau Sample Rate de 128kbps.
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Matricules Archiving Policy 

Catalogue Headings 
 

 
 

• There are 3 types of items that can be catalogued: 
 

1. A document 
2. An event 
3. An entity (individual or organisation) 
 

Each category has its distinct database system for cataloguing with a specific heading 
to manage the content. Please refer to the correct section depending on the type of 
item you are cataloguing. 
 

• General guidelines: If you do not know the information, leave the field blank. Do not 
invent or hypothesize information. 

 
 
DOCUMENT FIELDS 
 

* = Mandatory fields 
 

1. * Accession Number: This is the unique identifier number for each document (Please 
see the following document for further clarification). 

 
2. * Recurring Activities: Select from the list (FBR, FES, ADM, etc – see accompanying 

document for item labels). 
 

3. * Medium: Select from the list (audio, audio/visual, paper print, electronic print, etc.) 
 

4. * Support: Select from the list (Mini DV, Mini Disc, VHS tape, PDF, etc.) 
 

5. * Author: Refers to who produced the item. This is not the name of the person 
speaking in the video, etc. but, rather, the name of the person or institution 
responsible for creating the document. Thus, for the majority of documents the Author 
will be ‘Studio XX.’ 

 
6. * Official title: This is exactly what is written on the item; regardless of whether or 

not this is an accurate reflection of the content. No subjective judgments are to be 
made at the cataloguing stage; the title is whatever is written in the normal title space 
on the item. It is, therefore, an Official title and could be something like: “Femmes 
Branchées/Cameraman: Caroline Martel.” 
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7. * Date: Is the date of the creation of the document. This date represents the date the 
video was shot, the date the CD was burned, etc.  In the case of a website, the date 
specified is when the URL was last visited.  NB: The format for the date must always 
be entered as MONTH/DAY/YEAR.  If the date is unknown or partially unknown, or if 
only the year is noted, enter 01/01/YEAR or 01/01/01. 

 
8. Physical description: Other relevant information about the physical aspects of the 

document such as brand, duration, length, size of document, colour, etc. The physical 
description can be written in either French or English. 

 
9. Content description: Description of content - if available.  For instance: the subjects 

recorded in the audio-visual material, the project description, bibliographical 
references for published material.  The content description can be written in either 
French or English. 

 
10. Source documents (documents “afférents): List the accession numbers of all 

reference documents. 
 

11. Archivist’s notes: These are notes made by the cataloguer and/or the archivist. They 
can include any information the cataloguer and/or archivist deems pertinent. Examples 
might include: “This is CD 3 of a 5 CD set”, “The CD appears scratched”, “The audio 
tape is missing its case”, etc.  

 
12. Location: This refers to the number indicated on the box in which the item is stored. 
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EVENTS 
 

1. * Title: Is the title of the event.  If distinct titles exist in both English and French, 
enter both titles. 

 
2. Participants: Lists the names of the participants. 

 
3. Funders: List the names of funders (i.e.: entities or organisations). 

 
4. * Date: The date of the event.  The date of the event must always be formatted 

MONTH/DAY/YEAR. 
 
5. Description A: Description of the event in French– only if available. Usually directly 

copied from grant or website, but can also include pertinent information, such as: the 
affiliation of the participants, information about funders and co-producers, etc. 

 
6. Description B: Description of the event in English– only if available.  
 
7. Archivists notes: Internal notes made by the cataloguer or archivist related to the 

archiving process or data entries such as issues related to clarity of information, items 
or missing information, etc. 

 
8. * Source documents: This field includes the document numbers of any documents that 

relate to the event. 
 
 
 
 
ENTITIES 
 
The cataloguing of individuals and organizations involved in the studio’s activities will exist in 
a relational searching process derived from information entered in the fields of descriptions, 
authors and participants. 
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Document Item Labels By Accession Numbers 
 

 
Accession Numbers 
 
All items should be catalogued with an accession number that takes the following form: 
 
Year (4 numbers), Cataloguing tag (3 CAPITAL letters referring to the recurring activities of 
the studio), Function (one number), Unique identifier number (4 random digits, starting with 
0001 and going up), Status (letter). 
Example: 2001FBR70001M 
 
If there is more than one copy of an item, the first label is followed by “- 1”, the second is 
followed by “- 2”, etc. 
 
If unsure of the cataloguing tag, put “---“ instead. 
Example: 2003---0003 
 
Classification categories (Recurring Activities) 
 
FBR = Femmes branches. 

Including Méta Femmes branchées (presentations + workshops). 
 
FES = Festival (Maid in Cyberspace/HTMlles). 
 
EVS = Special events organised by Studio XX. 

Including all types of events presented outside of the series Femmes Branchées, Méta 
Femmes branchées and the Festival. 

 
PRS = Special projects produced by Studio XX. 
 Projects such as research, outreach and productions of Studio XX. 
 
FOR = Training (workshops, master classes, courses). 
 
RES = Solely projects by artists in residence.  
 
COP = Co-productions and co-presentations. 
 Projects, activities, art events for which Studio XX is a facilitator. 
 
PUB = Printed or electronic publications (.dpi). 
 
PRM = Media programming (XX Files). 
 
ADM = Key administrative documents related to the organizational structure of the studio, 
specifically the charter, list of statements of mandates, AGM reports, list of team and board 
members/year, organizational structure, yearly programming and production grants from the 
Canada Council, etc.  
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Function  
 
 
Each document catalogue item can be identified as performing one of four functions: 
 
Administration:  Administrative documents are both a function and an activity.  They include 
documents that are the back up of administrative documents. 
This is coded as FUNCTION 1. 
 
Factual live recordings:  Includes all documents that record events, aka “documentation”.  
Examples: Video, audio, photographic records of events. 
This is coded as FUNCTION 3. 
 
Accompanying Materials: Any documents/items relating to or about an event including 
artworks, works presented at the studio, publications from events, artist’s statements, and 
bios. 
This is coded as FUNCTION 5. 
 
Promotional Materials:  Posters, flyers, press. 
This is coded as FUNCTION 7. 
 
No specific function: 
Some projects that cannot be categorized according to the four above-mentioned functions 
are primarily listed as an independent activity (the best examples would be dpi and websites 
not related to events or residencies). 
This is coded as FUNCTION 0. 
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Status 
 
Each catalogue item code must indicate whether or not it is an original document, a copy, a 
working document or a printed version.  Some items may have different versions (i.e., 
original, copy, working version), which means they have the same accession number but each 
item would have a different status code.  
 
Status terminology changes when dealing with different media (i.e., Audio-visual documents 
vs. print and digital documents) but for the purposes of the usability of archived information, 
Matricules has simplified the terms accordingly: 
 
O = Original document. An original document is the first recording (for audio visual 
documents), the digital file of a printed poster, the website, etc.  NB: for the purposes of the 
Matricules project, the most pertinent version is the original. 
 
C = Copy (used only for audio visual recording).  Refers to a direct copy of the original 
document.  It is unlikely that the studio would have many copies of audio-visual recordings. 
 
W = Working document.  Refers to elements that are used in the production of a document.  
Ex: The electronic work file for the design of promotional material. 
 
P = Electronic version (PDF) or paper version for which there is an original electronic file. 
Example: 
 

• You are cataloguing a poster. 
• Does the poster have an accompanying digital file? 
• If yes, then the digital file is the most pertinent and is therefore labelled as original. 
• If not, then the poster will be the original. 
• If there are associated files/elements that have gone into the production of the digital 

file, then these are working versions. 
• The PDF made during the archiving process of the digital file is the Print version of the 

item. 
 
Each of these versions as well as each item will have its own accession number that will be 
identical to the related documents, except for its status code.  
 
If there is more than one copy of an item, the first label is followed by “- 1”, the second is 
followed by “- 2”, and so on. 
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Lexicon for Descriptions 
 
When entering the physical description and the content description of an item, language 
should be consistent to guarantee the linked relationships between items. 
 
Physical Description 
 
In addition to listing the colour, size, and type of the item, the most accurate physical 
description will use the following classifications for the medium and the support material: 
 
Medium options: 
Audio 
Audio/Visual 
Electronic Print 
Paper Print 
Electronic File 
Other 
 
Support options: 
Audiocassette  
Binder  
Book  
Brochure  
Catalogue  
CD  
DAT  
Digital Multimedia 
Digital Photograph 
DVD  
Floppy disc  
Hi8  
Invitation  
Journal  
Mini disc  
Mini DV  
PDF  
Photograph 
Poster  
Program  
Report  
Slide  
Travan drive  
VHS  
Zip disc  
Other  
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Recommendations 
 

 
 

• Archived Items should be stored by year in both digital storage systems and physical 
storage systems. 

 
• Digital files should be transferred from discs to the server and then to the external 

archive. 
 

• When a file already exists on the server the back-up diskette is unnecessary. 
 

• For promotional print material, it is only important to save approximately 10 copies. 
 

• PDF’s of all possible files should be created and stored on the external hard-drive. 
 

• The external hard-drive archives should be categorically organized according to the 
system described by the accession numbers. 

 
• If possible, do not label CDs or DVDs with a regular pen or with stickers.  Archival 

quality pens should be used for labelling disks if necessary. 
 

• All future CDs, DVDs, Cassettes, Mini DVDs, should be labelled with the following 
information: Title, author, date, and event. 

 
 
 
 

 
 
 


